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Objectives
To be able generate a text chart from a given text
Text Charting
Discourse analysis has as its focus linguistic phenomenon at greater than word level. This means that the structure of entire text is of interest. 
One of the primary tools that a linguist uses to answer these questions is the discourse chart. One of the primary types of chart is the Text Chart. The Text Chart is made by putting the text in a table so that generally each clause is on a separate line with the various phrases in the clause spread out to their own columns. This allows the linguist to see at a glance if certain verb tenses or aspects entail "different" behavior elsewhere in the clause, or if certain particles always show up at a certain point in a story, but not in others, etc. It also makes it easy to see if something (e.g. a Noun Phrase) occurs out of its "normal" position.
How to generate a chart from text?
First, create a new project
0. On the File menu, click New FieldsWorks Project.
The New FieldsWorks Project dialog box appears.
In the Name the project area, in the Vernacular language writing system area, select Ekoti.  If, necessary, you may need to define a new writing system call Ekoti.   In the Analysis language writing system area, select English. Then Click OK.
The project is created.

Second, copy the text to baseline.
0. Click Text & Words.
0. Click Info tab.  In the Title boxes, type Hantisi and Story,
0. Click Baseline tab. Copy first section from Ekoti Text.rtf to the baseline.

Third, interlinearize the first sections of the text using Ekoti Chart.rtf as a guide.
0. On the Tools menu, point to Configure and click Interlinear. In the Displayed Item box, select Word, Word Gloss and Free translation.
0. Click Gloss tab.  Then gloss the displayed text.
Click the word for which you will specify a word gloss.
The word appears in a word focus box.
In the Word Gloss line, do one of the following:
Click the white box, and then enter a new gloss or edit the existing gloss. 
Click the down arrow, if present, and then select an existing gloss, or select New word gloss.
If you select New word gloss, the Word Gloss line(s) clears (white text box becomes empty) so you can enter a new gloss. 
To approve the gloss, enter the gloss and click the green check icon or press Enter.
The Word Gloss down arrow only occurs when the word has one or more analyses and the current analysis in use by the focus box has one or more word gloss. You can select one of those glosses.  You can click the down arrow in the Word line, select New word gloss, and then enter a new gloss in the Word Gloss line.  The Word Gloss down arrow list will contain the selectable command "<Empty>" after you have left the word with the Word Gloss line empty and then return to that word. This allows you to examine and close the menu while retaining an empty Word Gloss line.
If you specify a different word gloss such that the previous word gloss is no longer referenced by the current analysis, the previous word gloss will be automatically removed from the Word Gloss list.
To combine two words into one phrase, click on the chain link icon between the two words.
To add the free translation, click on the Free text box and enter the free translation.
In Texts & Words, these commands may also be available:
Approve and Move Next  (Green check icon)
This approves the analysis in the word focus box and moves the focus to the next word or phrase. Equivalent: Press Enter.
Approve Throughout this Text (Green check plus icon_
This approves the analysis in the word focus box for all instances of the same analysis in the current text, and moves the focus to next word or phrase. Equivalent: Press Ctrl+E.
Approve and Jump to Next Incomplete
This approves the analysis in the word focus box and jumps to the next word or phrase with a suggested or incomplete analysis. Equivalent: Press Ctrl+J.
Approve and Stay
This approves the analysis in the word focus box and keeps the focus on the same word or phrase. Equivalent: Press Ctrl+S.
.
Fourth, chart the first sections of the text using Ekoti Chart.rtf as a guide.
0. Click Text Chart tab.  Then process the text at the bottom of the window, putting them in the appropriate columns.
To insert words into the chart:
In a Text Chart tab, vernacular words and their word glosses appear in the bottom pane of this tab. The first displayed word or phrase is selected. If appropriate, select one or more subsequent words that you want to insert into the chart into the same row (clause) and column.
Do one of the following using the buttons at the bottom of the particular column into which you want to insert the word or words:
Click the button with the up-arrow. This inserts the selected word or words into that column in the lowest row.
Click the button with the down-arrow, and then select Insert into new Row. This inserts the words into that column but in new row, which is a new clause.
Click the button with the down-arrow, point to Insert as Moved from, and then select a column. This inserts the word or words into the chart in an order other than their default word order. The word(s) appear in the column you selected, and a preposed from or postposed from marker appears in the default column.
The selected word(s) are moved from the bottom pane into the chart column. The next word or phrase is automatically selected in the bottom pane so you can repeat the steps above until the bottom pane is empty.
To merge with cell before/after this:
Click the cell you want to merge with an adjacent empty cell or cells, and then click Merge with Cell before this or Merge with Cell after this on the menu that appears.  (There must be an empty cell next to the cell you clicked, for the menu commands to appear.)
The cell with content and the adjacent cell or cells appear to be one cell and the content uses all of the area of those cells. Also, a check mark appears next to the menu command you clicked.
To insert row below:
In a Text Chart tab, click the appropriate row in the chart, and then select Insert Row Below on the menu that appears. An empty row appears below the row you clicked.
You can then move a word or move a cell to this new row.
To move cell (all words):
In a Text Chart tab, click the cell that has the words you want to move. Point to Move Cell on the menu that appears, and then select Forward or Back.  All of the words in the cell move in the selected direction, according to the direction of the vernacular writing system whether left-to-right or right-to-left.  
Markers (Preposed from, Postposed from, Grammatical Information, and so on) do not move, so you need to review your markers. Remove and replace them as necessary.
To move one word of cell:
In a Text Chart tab, click the cell that has word you want to move. Point to Move Word on the menu that appears, and then select Forward or Back.  The word that is permitted to move forward or back moves in the direction you selected.
Markers (Preposed from, Postposed from, Grammatical Information, and so on) do not move, so you need to review your markers. Remove and replace them as necessary.
To mark last row of sentence or paragraph:
In a Text Chart tab, do one of the following to mark the end of a sentence or paragraph: 
Click the row you want as the last row in the sentence, and then select Last Row in Sentence.  The line-weight of the line at the bottom of the row changes to the medium weight, indicating the end of a sentence.
Click the row you want as the last row in the paragraph, and then select Last Row in Paragraph.  The line-weight of the line at the bottom of the row changes to the heaviest weight, indicating the end of a paragraph.
To make a dependent clause out of:
In a Text Chart tab, if the dependent clause precedes the independent clause, click the cell that precedes the independent clause (usually the preceding Outer column). Or, if the dependent clause follows the independent clause, click the cell that follows the independent clause (usually the following Outer column).
Point to Make a Dependant Clause out of on the menu that appears, and then click one of the following:  Previous Clause or One of the available Next Clause commands or Other.
If the Select Clauses dialog box appears, select the first previous row or last following row of the dependent clause. Then, all the rows that comprise the dependent clause, up to the independent clause, are marked as dependent. Click OK.
Clause markers appear.
To make a speech clause out of:
In a Text Chart tab, click that cell that appears immediately before or after a speech clause. Point to Make a Speech Clause out of on the menu that appears, and then click one of the following: Previous Clause or One of the available Next Clause commands or Other.
If the Select Clauses dialog box appears, select the first previous row or last following row of the dependent clause. Then, all the rows that comprise the dependent clause, up to the independent clause, are marked as dependent. Click OK.
Clause markers appear.
To make a song clause out of:
In a Text Chart tab, click the cell that appears immediately before or after a song clause. Point to Make a Song Clause out of on the menu that appears, and then click one of the following:  Previous Clause or One of the available Next Clause commands or Other.
If the Select Clauses dialog box appears, select the first previous clause or last subsequent clause that is part of the song clause. This selection specifies that the selected clause (row) and all the clauses up to the current cell are part of the same song clause. Click OK.
Clause markers appear.
To mark as preposed from:
In a Text Chart tab, click the cell that has the word or words you want to mark as preposed. 
Point to Mark as Preposed from on the menu that appears, and then select the desired column in the current clause or select Another clause.
If the Mark As Preposed from another Clause dialog box appears, select the Row (clause) and Column that you want to mark as the default position of the word(s). Click OK.
The two colored markers appear in the chart. Also, a check mark is added to the submenu command that you selected.
To mark as postposed from:
In a Text Chart tab, click the cell that has the word or words you want to mark as preposed.
Point to Mark as Preposed from on the menu that appears, and then select the desired column in the current clause or select Another clause.
If the Mark As Preposed from another Clause dialog box appears, select the Row (clause) and Column that you want to mark as the default position of the word(s). Click OK.
The two colored markers appear in the chart. Also, a check mark is added to the submenu command that you selected.
To mark grammatical information:
In a Text Chart tab, click the cell (row and column) which has the content that you want to mark with grammatical information.
In the menu that appears, point to one of the menu commands, such as those listed below. Then, select the desired grammatical marker on a submenu.
Mark TenseAspectMood
Mark Pronouns
Mark Demonstratives
The selected grammatical marker appears in the cell, colored and in a parentheses. Also a check mark is displayed next to that marker in the submenu, which indicates that it is used in the current cell.
To mark as missing:
In a Text Chart tab, click (or right-click) the cell in which you will mark, and then select Mark as Missing on the menu that appears.
The marker, ---, is inserted in the cell. Also, a check mark is added to the menu command.

Fifth, generate a soft copy of the chart that can opened in a word processor
0. To generate a soft copy of the chart, in the File menu, click Export Discourse Chart.
The Export Discourse Chart dialog box appears. Select Microsoft Word XML and click Export.

Have the participants practice the process on their own with the other sections from the Ekoti Text file.
Have the participants chart some text from their own language.
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